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บทคดัย่อ 

การทาํกราฟิก 2D และ แอนิเมชัน เพ่ือการพฒันาเกม จะตอ้งมีพื้นฐานการวาดรูปเป็น
สาํคญั มีจินตนาการให้กบัการดีไซน์ตวัละคร มีความเขา้ใจในงานแอนิเมชนัเบ้ืองตน้ เพื่อทาํ Sprite 
เกม ให้กบันกัพฒันาเกม มีการใชโ้ปรแกรมอ่ืนๆเช่น โปรแกรม 3D เขา้มาช่วยในงาน เพ่ือให้การ
ทาํงานมีความถูกตอ้งแม่นยาํมากข้ึน และจะตอ้งเสริมความรู้ทางดา้นโปรแกรมพฒันาเกมดว้ย ซ่ึง
ส่วนน้ี จะเกิดข้ึนจากการทาํงานการเป็นทีมกบัทางผูพ้ฒันาเกมโครงงานเล่มน้ี จะแสดงถึงงาน 2D 
ต่างๆ ความรู้เบ้ืองตน้ท่ีควรมี เพือ่ใหน้กัพฒันาเกมนาํไปใชใ้นเกม 
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Summary 

 In game development, 2D graphics, animations, sprites design and character design are 
essential for the success of the game. These components could not be created without drawing 
skills, creativity and most importantly, understanding in animation. Many software such as 3D 
modeling software are also used to ensure accuracy in creating sprites for games and game 
engines. This project will showcase 2D graphics, animation, sprites and other game development 
related work produced during the cooperative education internship period. 
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กติิกรรมประกาศ 

 รายงานฉบบัน้ีเกิดข้ึนจากการรวบรวมผลงานของขา้พเจา้ท่ีทาํข้ึนในช่วงปฏิบติังานสหกิจ
ศึกษา ณ บริษทั Debuz Company Limited ในช่วงระหว่างวนัท่ี 2 มิถุนายน พ.ศ. 2558 ถึงวนัท่ี 30
กนัยายน พ.ศ. 2558 ซ่ึงผลจากการปฏิบติังานสหกิจคร้ังน้ีทาํให้ขา้พเจา้ไดรั้บประสบการณ์ในการ
ทาํงานจริง ความรู้และเทคนิคต่างๆท่ีขา้พเจา้สามารถนาํมาปรับใชใ้นการพฒันาตวัขา้พเจา้เอง ซ่ึง
ประสบการณ์และความรู้ท่ีได้รับน้ีเป็นส่ิงท่ีมีค่าแก่ตวัขา้พเจ้าเป็นอย่างมาก นอกจากนั้นแลว้ยงั
ไดรั้บการดูแล เอาใจใส่ และการแนะนาํจากบุคลากรหลายๆท่านในบริษทัมาโดยตลอด 

 ทั้งน้ี การท่ีโครงงานวิชาสหกิจศึกษาฉบบัน้ีสาํเร็จลงไดด้ว้ยดีก็เพราะไดรั้บความช่วยเหลือ
และสนบัสนุนอยา่งดีจากบุคลากรหลายๆท่าน ดงันั้นขา้พเจา้จึงขอลงนามขอบคุณไว ้ณ โอกาสน้ี 

1. นาย ธีรวฒัน ์  พิทยาภรณ์  ตาํแหน่ง ประธานกรรมการบริหาร 
2. นาย วิชชุ   พร้อมจรรยากุล  ตาํแหน่ง ผูบ้ริหาร 
3. นาย ฉนัทวิทย ์  พงษศิ์ริ   ตาํแหน่ง กรรมการผูจ้ดัการ 
4. นาย สิทธิชยั   เทพไพฑูรย ์  ตาํแหน่ง กรรมการผูจ้ดัการ 
5. นาย เฉลิมยศ  เตชะกาํธร  ตาํแหน่ง หวัหนา้ฝ่ายกราฟิก 2D 
6. นาย กฤติณฐั  สุวรรณมณี  ตาํแหน่ง กราฟิก 2D 
7. อาจารยภ์ูวดล  ศิริกองธรรม  ตาํแหน่ง อาจารยท่ี์ปรึกษาโครงงาน 

 
 นอกจากนั้นแลว้ก็ขอแสดงความขอบคุณแก่ทุกๆท่านท่ีให้ความช่วยเหลือ ให้คาํแนะนาํ 
และเป็นท่ีปรึกษามาโดยตลอดจนกระทัง่รายงานฉบบัน้ีเสร็จสมบูรณ์ ทั้งยงัดูแลและสอนส่ังขา้พเจา้
ในเร่ืองของการทาํงานจริงดว้ย ขา้พเจา้กข็อขอบคุณมา ณ ท่ีน้ี 
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4.61 Mock up “เมืองซอมบ้ี” เกม Rush for Life      56 
4.62 3D Model “ป้ายรถเมล”์ นาํมาทาํเป็น 2D เกม Rush for Life    57 
4.63 “เสาไฟ” เกม Rush for Life       57 
4.64 “ตึกแถว” เกม Rush for Life       58 
4.65 “ฟุตบาท” เกม Rush for Life       58 
4.66 “ถนน” เกม Rush for Life       58 
4.67 “เดก็ผูช้าย” เกม Rush for Life       59 
4.68 “เดก็ผูห้ญิง”  เกม Rush for Life       60 
4.69 “คุณลุง”  เกม Rush for Life       61 
4.70 “ซอมบ้ี”  เกม Rush for Life       62 
4.71 “รถพยาบาล”  เกม Rush for Life       63 
4.72 ภาพการเรียง Sprite “รถพยาบาล”  เกม Rush for Life    64 
4.73 ภาพการเรียง Sprite “รถพยาบาล”  เกม Rush for Life    65 
4.74 ภาพการเรียง Sprite “รถพยาบาล”  เกม Rush for Life    66 
4.75 ภาพการเรียง Sprite “รถเมล”์  เกม Rush for Life     67 
4.76 ภาพการเรียง Sprite “รถยนต”์  เกม Rush for Life     68 
4.77 ภาพการเรียง Sprite “รถกระบะ”  เกม Rush for Life    69 
4.78 ภาพการเรียง Sprite “รถกระบะ”  เกม Rush for Life    70



 

บทที่ 1 
บทนํา 

 

1.1 ช่ือและทีต่ั้งของสถานที่ประกอบการ 
 

บริษทั ดีบสัซ์ จาํกดั (DEBUZ Co., Ltd. ) 
 

 
 
 
 

ภาพท่ี 1.1 โลโกของบริษทั ดีบสัซ์ จาํกดั 
 
สถานท่ีตั้ง : เลขท่ี 21/1001 หมู่ 5ถนนนวมินทร์ แขวงคลองกุ่ม บึงกุ่ม  กรุงเทพมหานคร 10240 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที ่1.2 แผนท่ีสาํหรับเดินทางมาท่ีบริษทั 
 

1.2 ลกัษณะธุรกจิของสถานประกอบการ หรือการให้บริการหลกัขององค์กร 
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พฒันาซอฟตแ์วร์เกม ใหบ้ริการเกมออนไลน ์สร้างเกมบน PC และ Mobile Game 
 

1.3 รูปแบบการจัดองค์กรและการบริหารองค์กร 

ในบริษทัดีบสัซ์ จาํกดั มีพนกังานประมาณ 20 - 30 คน ซ่ึงในบริษทัมีหลากหลายแผนก ดงัน้ี 
1. Game Programmer 

2. 2D , 3DArtist and Advertisement 

3. Game Designer 

4. Game Tester 

 

1.4 ตําแหน่งและหน้าทีง่านที่นักศึกษาได้รับมอบหมาย 
2D Artist ออกแบบและทาํงานดา้น 2D Art ใหก้บัเกมส์ 
 

1.5 พนักงานทีป่รึกษา และ ตําแหน่งของพนักงานทีป่รึกษา 
นายเฉลิมยศ เตชะกาํธร 
ตาํแหน่ง : หวัหนา้ฝ่าย 2D Artist 
 

1.6 ระยะเวลาที่ปฏิบัติงาน 
วนัท่ี 2มิถุนายน ถึง30กนัยายน 2558 รวมระยะเวลาทั้งหมด 4 เดือน 

 

1.7 ทีม่าและความสําคญัของโครงงาน 
 ที่มาของโครงงาน - เน่ืองจากเทคโนโลยใีนปัจจุบนันั้น สามารถเขา้ถึงตวัผูค้นไดอ้ย่างง่าย
ข้ึน ทาํใหผู้ค้นเสพส่ือกนัไดง่้ายข้ึน และหลากหลายข้ึน ทั้งน้ีผูค้นบางกลุ่มก็ไดมี้ความสนใจใน
อาชีพ 2D Artist ไม่น้อยเลยทีเดียว การทาํโครงงานช้ินน้ีข้ึน เพ่ือให้ผูค้นท่ีอยากจะมาทาํงาน
สายน้ี ไดเ้รียนรู้เก่ียวกบัความสาํคญั และ คุณสมบติัท่ีพึงมี เพ่ือใชก้ารทาํงานสายน้ี และช่วยใน
การตดัสินใจให้ผูท่ี้ยงัคงสงสัยว่า งานสายน้ีจะตอ้งทาํอะไรบา้ง และเป็นแนวทาง ให้กบัผูท่ี้
สนใจไดศึ้กษาล่วงหนา้ พฒันาฝีมือของตนเอง ก่อนท่ีจะเขา้มาสู่การทาํงานในอาชีพน้ี 
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 ความสําคัญของโครงงาน - รายงานท่ีจดัทาํน้ีน่าจะช่วยเป็นแนวทางให้ใครท่ีอยากศึกษา
แนวทางการทาํงานของ 2D Artist ในบริษทั Debuz Company Limited ได ้
 

1.8 วตัถุประสงค์หรือจุดมุ่งหมายของการปฏิบัติงานหรือโครงงานสหกจิศึกษา 
 
1. เพ่ือเป็นแนวทางใหผู้ท่ี้สนใจการทาํงานของ 2D Artist ในบริษทัพฒันาเกม 
2. ผูท่ี้สนใจจะทาํงานดา้นน้ี สามารถทาํความเขา้ใจไดว้่าตวัเองตอ้งฝึกฝนฝีมือดา้นใดเพ่ือท่ีจะ
เขา้มาทาํงานในสายงานน้ีได ้
3. เพ่ือให้บุคคลทัว่ไปเขา้ใจได้ว่างานของ 2D Artist ไม่ใช่แค่วาดรูป อย่างเดียว แต่จะตอ้งมี
ความรู้ ความเขา้ใจในดา้นต่างๆของงานส่วนอ่ืนดว้ย 
4. เพ่ือใหบุ้คคลทัว่ไปเห็นความสาํคญัของสายงาน 2D Artist 
5. เพ่ือเป็นแรงบนัดาลใจใหก้บัผูท่ี้สนใจและอยากจะทาํอาชีพ 2D Artist 
 

1.9 ผลทีค่าดว่าจะได้รับจากการปฏิบัติงานหรือโครงงานที่ได้รับมอบหมาย 
 
1.ผูอ่้านสามารถทาํความเขา้ใจไดว้่า 2D Artist ทาํงานกนัอย่างไรในบริษทั Debuz Company 
Limited 
2.ทาํใหบุ้คคลทัว่ไปเห็นความสาํคญัของอาชีพ 2D Artist ว่ามีความสาํคญัไม่แพอ้าชีพอ่ืนๆ 
3.บุคคลทัว่ไปเขา้ใจในขั้นตอนการทาํงานของ 2D Artist 
4.ผูอ่้านไดรั้บรู้ประสบการณ์ และการทาํงานของผูจ้ดัทาํเพ่ือนาํไปใชพ้ฒันาฝีมือของผูอ่้านได ้
5.ผูอ่้านเขา้ใจในหลกัการดีไซนต์วัละคร เบ้ืองตน้ 
6.ผูอ่้านเขา้ใจในหลกัการใช ้Pixel art และการ Animate pixel art เบ้ืองตน้ 
7.ผูอ่้านเขา้ใจในหลกัการใช ้3D มาช่วยในงาน 
8.ผูอ่้านไดเ้ขา้ใจถึงหลกัการในการสร้างเกมส์ข้ึนตั้งแต่ตน้ จนถึงสามารถนาํใหผู้อ่ื้นไปต่อยอด
ได้



 

บทที่ 2 
ทฤษฎแีละเทคโนโลยทีีใ่ช้ในการปฏิบัติงาน 

 

2.1 เทคโนโลยท่ีีใช้ในการปฏิบัติงาน 
2.1.1  Computer Laptopท่ีใชใ้นการปฏิบติังาน 
 

 
 

 

 

ภาพที ่2.1 Computer Laptop ท่ีใช ้

• Dell Inspiron N5010 
• OS: Windows 7 Professional 32 bit 
• CPU : Intel(R) Core(TM) i5 CPU M430 @ 2.27GHz (4CPUs), ~2.3GHz 
• Installed memory(RAM) : 4 GB (2.99 GB usable) 
• VGA : ATI Mobility Radeon HD 5470 
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2.1.2 เมาส์ปากกาท่ีใชใ้นการปฏิบติังาน 
 

 
 

ภาพที ่2.2 เมาส์ปากกา Wacom Bamboo Pen & Touch 

 
 เมาส์ปากกามีความสําคญัอยา่งมากสําหรับ 2D Artist เป็นเคร่ืองมือท่ีช่วยให้การทาํงานมี
ความสะดวกสบายมากข้ึน ควรจะเลือกเมาส์ปากกาท่ีมีขนาดท่ีพอเหมาะ ถนดัมือ และเป็นยี่ห้อท่ี
ไวใ้จได ้เพราะเน่ืองจากเมาส์ปากกาท่ีมีราคาถูก อาจจะพงัเร็ว ไม่ทนทาน 
 

2.2 ทฤษฏีทีใ่ช้ในการปฏิบัติงาน 
 
2.2.1 คาํศัพท์ทีใ่ช้ในการทาํงาน  
2D  , 2-dimensions สองมติิ 
 งานสอง-มิติ (2D) เป็นงานท่ีเกิดจากการวาดภาพบนแกน 2 แกน คือแนวตั้งและแนวนอน
เราสามารถพบเจองาน สองมิติ น้ีไดจ้ากหนงัสือการ์ตูนหรือรูปวาด ภาพเขียนต่างๆ 
3D , 3-dimensions สามมติิ 
 งานสาม-มิติ (3D) คือเทคโนโลยีของการผลิตภาพอยา่งหน่ึง ซ่ึงจะมีมิติ "ความลึก" เขา้มา
เก่ียวขอ้ง งานสามมิติน้ี จะใชค้อมพิวเตอร์เขา้มาช่วยในการทาํงานดว้ย และดว้ยเทคโนโลยีท่ีดีข้ึน 
ทาํให้ปัจจุบนัเราจะพบเห็น อนิเมชัน่  และเกม ท่ีเป็นสามมิติ อยู่มากมาย ซ่ึงบางคร้ัง งานสามมิติ 
สามารถนาํมาช่วยใหง้าน สองมิติ มีความสมจริงยิง่ข้ึนได ้
 
 
Mock up 
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คือการร่างแบบคร่าวๆ เพ่ือใหเ้ราเห็นภาพรวมทั้งหมด คาํว่า Mock up ในท่ีน้ี สามารถใชไ้ด้
กับหลายอย่าง ทั้ งการทําเวปไซต์ การทําเกม หรือการทํา Mobile app การ Mock up นั้ น  เป็น
ส่ิงจาํเป็น ใชเ้พ่ือในการคุยกบัลูกคา้ หรือผูร่้วมงาน เพ่ือใหเ้ห็นภาพโดยรวม และมีความเขา้ใจ ของ
ส่ิงท่ีกาํลงัจะทาํร่วมกนั 
Pixel 
 จุดภาพ หรือ "Pixel" ท่ีนาํมาประกอบกนัจนเป็นรูป โดยภาพหน่ึงๆจะประกอบไปดว้ย จุด
พิกเซลท่ีว่าน้ีมากมาย ในแต่ละภาพจะมีความหนาแน่นของจุดภาพแตกต่างกนั ยิง่มีความหนาแน่น
มาก ยิ่งละเอียดมาก จึงทาํให้พิกเซลสามารถใช้ในการบอกคุณสมบติัของ จอภาพ หรืออุปกรณ์
แสดงผลภาพได ้
Pixel Art 

คืองานศิลปะอยา่งหน่ึง ท่ีใชค้อมพิวเตอร์เป็นตวัช่วย ซ่ึงเม่ือก่อนการท่ี Pixel art เกิดข้ึนได ้
เพราะเทคโนโลยคีอมพิวเตอร์ ยงัไม่มีความสามารถพอท่ีจะแสดงความละเอียดภาพไดม้ากกว่านั้น 
พวกเราๆจึงอาจจะเคยไดย้นิคาํว่า "เกม 8Bit" พวกน้ีมาบา้ง Pixel art จึงเป็นการนาํ จุดภาพ มาต่อกนั
จนเป็นรูปเป็นร่างข้ึน 
Pixel Animation 

คือการนาํรูปภาพแนว Pixel มาทาํให้มีความเคล่ือนไหว จะถูกใชม้ากในอุตสาหกรรมเกม 
ท่ีใช ้Pixel เป็นแนวภาพของเกม 
Isometric 

การเขียนแบบภาพไอโซเมตริกเป็นสิธีการเขียนภาพ สามมิติ ในรูปแบบ สองมิติ 
Power of 2 

คือชุดตวัเลข ท่ีเกิดจาก 2 ยกกาํลงัใดๆ แลว้จะไดต้วัเลขนั้นๆ  ซ่ึงตวัเลขชุดน้ี มีผลทาํใหก้าร
ทาํงาน ของตวัโปรแกรมนั้นดีข้ึน และรวดเร็วข้ึน กล่าวคือ ถา้ไฟลใ์ดๆ มีความกวา้งและยาวเป็น
ตวัเลข ท่ีเกิดจากยกกาํลงั 2 ใดๆ จะทาํให้โปรแกรม มีการทาํงานท่ีดีข้ึน และรวดเร็วข้ึนนั่นเอง 
ตวัอยา่งของตวัเลขยกกาํลงั 2 ไดแ้ก่ 256 512 1024 2048 ฯลฯ 

 
 
 

 
 
2.2.2 หลกัการทาํแอนิเมชัน แบบ Frame by Frame 
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 แอนิเมชันหรือภาพเคล่ือนไหวเป็นการทาํใหว้ตัถุใดๆเกิดการเคล่ือนท่ีดว้ยรูปแบบต่างๆกนั
บนจอภาพเช่นรถแล่นไปบนถนนแมลงคลานออกมาจากกองดินการเคล่ือนท่ีของอวยัวะส่วนต่างๆ
และลมพดัใบไม้ไหวแอนิเมชนัอาศยัปรากฏการณ์ทางชีววิทยาท่ีเรียกว่า“ความต่อเน่ืองของการ
มองเห็น”ร่วมกบัการทาํใหว้ตัถุมีการเคล่ือนท่ีท่ีความเร็วระดบัหน่ึงจนตาของเรามองเห็นว่าวตัถุนั้น
มีการเคล่ือนไหวเช่นคนเดินรถวิ่งเป็นตน้ 
 
 เฟรม (Frame) คือภาพน่ิงภาพหน่ึงๆท่ีเม่ือนาํมาเรียงต่อกนัจะเกิดเป็นภาพเคล่ือนไหวภาพ 
1 ภาพนบัเป็น 1 เฟรม 
 

 

ภาพที ่2.3รูปแสดงการเคล่ือนไหวทีละเฟรม 
 

 การสร้างแอนิเมชันแบบเฟรมต่อเฟรม (Frame by Frame) เฟรมต่อเฟรมเป็นการนาํภาพ
มาใส่ไว้ในแต่ละเฟรมและทําการกําหนดคีย์เฟรม  (คีย์เฟรมคือเฟรมท่ีถูกกําหนดให้มีการ
เปล่ียนแปลงของวตัถุเพ่ือสร้างการเคล่ือนไหว) ถา้กาํหนดให้คียเ์ฟรมมีช่องว่างห่างกนัเกินไปการ
เปล่ียนแปลงของภาพท่ีปรากฏออกมาจากเฟรมหน่ึงก็จะช้าลงทั้ งน้ีภาพท่ีปรากฏจะเกิดอาการ
กระตุกได้เน่ืองจากไฟล์มีขนาดใหญ่ข้ึนตามจาํนวนช่องคียเ์ฟรมนั่นเองดังนั้ นการสร้างการ
เคล่ือนไหวแบบ Frame by Frame จึงเหมาะสําหรับงานอนิเมชนัท่ีมีการเปล่ียนแปลงแบบรวดเร็ว
หรืองานท่ีซบัซอ้นมากๆ 

 

2.2.4 การเขียนภาพในรูปแบบ Isometric 
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การเขียนภาพแบบ Isometric เป็นหลกัการใช้ ในการสร้างรูปภาพให้กบัเกม Asura การ

เขียนแบบภาพไอโซเมตริกเป็นภาพลกัษณะสามมิติอีกแบบหน่ึงของการเขียนแบบ  มีลกัษณะเป็น
ภาพท่ีมองเห็นจากมุมท่ีกาํหนดเป็นจุดเร่ิมตน้  การสร้างภาพ Isometric น้ีจึงเป็นการวดัเอาขนาด
กวา้ง ยาว ของด้านต่าง ๆ มาเป็นขนาดในภาพนั้นเอง  การเขียนแบบภาพ Isometric จะมีความ
แตกต่างจากมุม Perspective เน่ืองจากมุม Isometric จะแสดงการเขียนโดยใชมุ้มทั้งสองขา้งเท่ากนั 
คือ เป็นมุม 30 องศา โดยวดัจากเส้นระนาบ 

 

 
 

ภาพที ่2.4ความแตกต่างระหวา่งมุม Isometric กบัมุม Perspective 

 
2.3 โปรแกรมทีใ่ช้ในการทาํงาน 
 
Paint Tools Saiโปรแกรม Painting หลกั ทาํงานง่าย ใชง่้าย และไม่ใช้ Spec เคร่ืองท่ีสูงมากนักเห
มากมาก สาํหรับคอมพิวเตอร์ ท่ีมี Ram นอ้ย 
 

 
 

ภาพที ่2.5 โปรแกรม Paint tools Sai 
 

Adobe Photoshop CS4ใช้สําหรับทําภาพ  Art ในรูปแบบ  Pixel art และใช้ Effect ช่วยเพ่ือให้
ทาํงานไดเ้ร็วข้ึน 
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ภาพที ่2.6 โปรแกรม Adobe Photoshop 
 
Blenderโปรแกรมสําหรับ 3D ท่ีเป็นโปรแกรมฟรีและไม่ใช้ Spec เคร่ืองท่ีสูงมากนักเหมาะมาก
สาํหรับคอมพวิเตอร์ท่ีมี Performance ไม่สูงมากนกั 
 

 
 

ภาพที ่2.7โปรแกรม Blender



 

บทที่ 3 
แผนงานการปฏิบัตงิานและขั้นตอนการดาํเนินงาน 

 

3.1 แผนงานปฏิบัต ิ

ตารางที ่3.1 แผนงานปฏิบติั 

งานท่ีปฎิบติั มิถุนายน กรกฎาคม สิงหาคม กนัยายน ตุลาคม 

ImFarm                     

Monster Design                     

Pixel Art Animate                     

Painting Item                     

Pixel BG Object                     

Color Palete Study                     

Monster Design                     

Landscape Painting                     

Painting Bg Mockup                     

3D Blender Study                     

Animate player Obj                     

Painting Bg for game                     

Animate NPC                     

Item Preview                     
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Final Mockup                     

รายงานสหกิจ                     

 

3.2 รายละเอยีดงานที่นักศึกษาปฏิบัติในสหกจิศึกษา 

 

3.2.1 Game Asura 

3.2.1.1 Character/Monster Designดีไซน ์Monster ตามธีมของกิจกรรมของเกมในตอนนั้น 

 

 

ภาพที ่3.1Character design  เกม Asura 
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3.2.1.2 Character/Monster Pixel ArtAnimate มอนสเตอร์ของเกม 

 

 

ภาพที ่3.2Character Dot pixel  เกม Asura 

 

3.2.1.3Item Designดีไซน์ไอเทมท่ีดรอปจากมอนสเตอร์ 

 

 

 

ภาพที ่3.3Item Design  เกม Asura 
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3.2.1.4Equipment Design / Item Preview / Pixel Artดีไซน์เส้ือผ้าตามงานท่ีได้รับ
มอบหมาย แลว้เปล่ียนรูปภาพนั้นใหอ้ยูใ่น 75*75 Pixel และในรูป Pixel art 

 

 

ภาพที ่3.4Equipment design  เกม Asura 

 

 

 

ภาพที ่3.5Equipment design  เกม Asura 
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3.2.1.5 Concept Art Painting ออกแบบบรรยากาศเมืองเอลฟ์ 

 

 

 

ภาพที ่3.6Concept art เมืองเอลฟ์เกม Asura 
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3.2.2 Game Rush for life 

3.2.2.1 Game Mockupออกแบบคร่าวๆใหเ้ห็นรูปเกม การเล่นเกมของเกม 

 

 

 

ภาพที ่3.7First Mockup  เกม Rush for Life 

 

 

 

ภาพที ่3.8Final Mock up เกม Rush for Life 
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3.2.2.2 Painting Background 

 

 

 

ภาพที ่3.9 ฟุตบาทเกม Rush for Life 

 

3.2.2.3Making Animate Player&NPCการใช ้3D เขา้มาช่วยในการทาํ Animate ทาํให้การ
Animate มีความถูกตอ้งมากข้ึน สามารถทาํงานไดเ้ร็วข้ึน และมีประสิทธิภาพ 

 

 

 

ภาพที ่3.10NPC คุณลุงเกม Rush for Life 
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3.2.2.4Making Decorate Backgroundทาํองคป์ระกอบของรูปใหดู้มีความสวยงามมากข้ึน 
โดยใช ้3D เขา้มาช่วย 

 

 

 

ภาพที ่3.11 ตึกเกม Rush for Life 



 

บทที่ 4 
ผลการดาํเนินงานการวเิคราะห์และสรุปผลต่างๆ 

 

4.1 ขั้นตอนและผลการดาํเนินงาน 

 ในหวัขอ้น้ี จะเป็นการอธิบายการทาํงานของ 2D Artist อยา่งละเอียดอีกคร้ัง โดยการทาํงาน
ของ 2D Artist ในแต่ละงาน จะขั้นตอน และวิธีการทาํท่ีแตกต่างกนั 

4.1.1 Game Asura 

4.1.1.1 Character/Monster Design เร่ิมแรกเรากท็าํการลอง Sketch ลงกระดาษมาหลายๆ
แบบ ใหพ่ี้ในทีมงานเลือก เพือ่นาํไปทาํกระบวนการต่อไป 

 

 

 

ภาพที4่.1 Character Design Angel เกม Asura 
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เม่ือพ่ีในทีมเลือกภาพร่างแลว้ เรากจ็ะทาํวธีิใดกไ็ด ้ท่ีจะนาํภาพในกระดาษใส่เขา้มาไวใ้น
คอมพิวเตอร์ก่อน ในท่ีน้ีทางผูจ้ดัทาํไดท้าํการถ่ายรูปลง และปรับขนาดใหดี้ 

 

 

 

ภาพที4่.2Character Design Angel”เยลล่ีศกัด์ิสิทธ์ิ”เกม Asura 
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 หลงัจากท่ีนาํไปใส่ไวใ้นโปรแกรมแลว้ จึงทาํการตดัเส้น และลงสีคร่าวๆ ให้รู้ว่าส่วนไหน
สีอะไรกเ็พยีงพอ 

 

 

 

ภาพที4่.3Character Design Angel”เยลล่ีศกัด์ิสิทธ์ิ”เกม Asura 

 

 

 

ภาพที4่.4Character Design Angel ”เยลล่ีศกัด์ิสิทธ์ิ”เกม Asura 
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ภาพท่ี4.5Character Design Elf“ท่อนไม”้เกม Asura 

 

 

 

ภาพที4่.6 Character Design Elf“ท่อนไม”้เกม Asura 
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ภาพที4่.7Character Design Elf “Bamboo Spirit”เกม Asura 

 

 

 

ภาพที4่.8Character Design Elf “Bamboo Spirit”เกม Asura 
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ภาพที4่.9Character Design Elf“Lazy Sheep”เกม Asura 

 

 

 

ภาพที4่.10Character Design Elf“Lazy Sheep”เกม Asura 
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ภาพที4่.11Character Design Elf “Fairy eater”เกม Asura 

 

 

ภาพที4่.12Character Design Elf “Fairy eater”เกม Asura 
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ภาพที4่.13Character Design Elf  “Werewolf” เกม Asura 

 

 

ภาพที4่.14Character Design Elf  “Werewolf” เกม Asura 
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4.1.1.2 Character/Monster Animate Pixel Artการ animate ตวัมอนสเตอร์ดว้ยโปรแกรม 
Photoshop จะใชห้ลกัการ Frame by Frame เขา้มาช่วยในการ Animateเร่ิมจากนาํตวัละคร ท่ี Dot 
pixel แต่ละท่าเสร็จแลว้นาํมาเขา้โปรแกรม 

 

 
 

ภาพท่ี4.15Pixel Animate เกม Asura 
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เม่ือเปิดโปรแกรมข้ึนมา ใหไ้ปท่ี Window > Timeline เพ่ือเปิด ฟังตช์ัน่ช่วย Animate  

 

 
 

ภาพที4่.16Pixel Animateเกม Asura 
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หนา้ตาหลงัจากเปิดช่อง Timeline ข้ึนมา  

 

 
 

ภาพที4่.17Pixel Animateเกม Asura 
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 หลงัจากนั้นให้เรากดปุ่มก๊อบป้ี (ตามลูกศรหมายเลข 1) เพ่ือท่ีจะก๊อบป้ีรูปน้ีไว ้หลงัจาก
ก๊อบป้ีแลว้จะมีเฟรมข้ึนมาใหม่ (ตามลูกศรหมายเลข 2) 

 

 
 

ภาพที4่.18Pixel Animateเกม Asura 
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 เม่ือเราทาํการเปล่ียนแปลงใดๆ ในเฟรมน้ี จะไม่มีผลกบัเฟรมเดิม ในท่ีน้ีทางผูจ้ดัทาํไดก้ด
ปุ่ม ปิดเฟรมเดิม (ปุ่มลูกตาตามลูกศรหมายเลข 1 ) และเปิดเฟรมใหม่ เพ่ือให้เฟรมใหม่เกิดการ
เปล่ียนแปลงของภาพ และลองกดปุ่ม เล่น ตวัเฟรมดูว่าดีหรือยงั ถา้ดีแลว้กว็นทาํใหม่อีกคร้ังจากวิธี
ทาํขา้งตน้ 

 

 
 

ภาพที4่.19Pixel Animateเกม Asura 
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4.1.1.3 Item Design 

 

 

ภาพที4่.20ไอเทม “หอกพงัๆ”เกม Asura 

 

 

 

ภาพท่ี4.21ไอเทม “เปลือกไม”้เกม Asura 
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ภาพที4่.22ไอเทม “ขนแกะข้ีเกียจ”เกม Asura 

 

 
 

ภาพที4่.23ไอเทม “เยลล่ีศกัด์ิสิทธ์ิ”เกม Asura 
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ภาพที4่.24ไอเทม “หน่อไมต้อ้งสาป”เกม Asura 

 

 
 

ภาพที ่4.25ไอเทม “Bike For mom Event”เกม Asura 
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ภาพท่ี4.26ไอเทม “ไมเ้ทา้พงั”เกม Asura 

 

 
 

ภาพที4่.27ไอเทม “ฝาขวด”เกม Asura 
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ภาพที4่.28ไอเทม “เปลือกหนามเกาลดั”เกม Asura 

 

 
 

ภาพที4่.29ไอเทม “หวัขนบุง้สุดคนั”เกม Asura 
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ภาพที4่.30ไอเทม “แหวน”เกม Asura 

 

 
 

ภาพที4่.31ไอเทม “เกราะพงัๆ”เกม Asura 
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ภาพที4่.32ไอเทม “หมวกจอมเวทย”์เกม Asura 

 

 
 

ภาพที4่.33ไอเทม “เปลือกฟาง”เกม Asura 
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ภาพที4่.34ไอเทม “ถุงมือขาว”เกม Asura 

 

4.1.1.4 Equipment Design / Item Preview / Pixel Artดีไซน์เส้ือผา้ของตวัละคร และการทาํ
ใหรู้ป painting กลายเป็น Pixel art 

 

 

 

ภาพท่ี4.35 Equipment Designเกม Asura 
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ภาพท่ี4.36 Equipment Designเกม Asura 

 

 เม่ือเราไดรู้ปจริงมาแลว้ ก็เร่ิมจากเราจะตอ้งย่อรูปให้ไดข้นาดเท่ากบั Preview Item ก็คือ 
72*72px 

 

 
 

ภาพท่ี4.37 Equipment Designเกม Asura 
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 รูปภาพหลงัจากยอ่รูปเหลือ 72*72px เซฟไวเ้ป็น Preview Item จากนั้นกย็อ่ใหเ้หลือ 32*32 
pxเพ่ือทาํ Pixel art ต่อ 

 

 
 

ภาพท่ี4.38 Equipment Designเกม Asura 
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 หลงัจากยอ่เหลือ 32*32 pxแลว้ ใหเ้ราไปท่ี Image > Mode > Indexed Color 

 

 
 

ภาพท่ี4.39 Equipment Designเกม Asura 
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 ทาํการเซ็ตค่าใหคุ้ณภาพรูปท่ีออกมากลายเป็น จุดสี Pixel art มากท่ีสุด 

 

 
 

ภาพท่ี4.40 Equipment Designเกม Asura 
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 เม่ือไดแ้ลว้กท็าํการเกบ็รายละเอียดโดยการ Dot pixel เพ่ิมลงไปในบางส่วนใหส้วยงาม 

 

 
 

ภาพท่ี4.41 Equipment Designเกม Asura 
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 หลงัจากท่ีเกบ็รายละเอียดเสร็จแลว้กก็ลบัไปท่ี  Image > Mode > RGB Mode เหมือนเดิม 
และเซฟ เกบ็เอาไปใชใ้นเกม 

 

 
 

ภาพท่ี4.42 Equipment Designเกม Asura 
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 ภาพที4่.43 Assasin “ชุดไหมเทพอคันี”เกม Asura 

 

 
 

ภาพที4่.44 Beastwarrior “เกราะเพลิงคาํราม” เกม Asura 
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ภาพที4่.45 Cleric ”เส้ือคลุมนกับวชแห่งไฟ” เกม Asura 

 

 
 

ภาพที4่.46 ElementBladeMaster“เส้ือหนงัเพลิงตะวนั” เกม Asura 
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ภาพที4่.47 Medium “เส้ือคลุมผนึกเพลิงกลัป์” เกม Asura 

 

 
 

ภาพที4่.48 Spirit“เส้ือคลุมเพลิงนรก” เกม Asura 
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ภาพที4่.49 Warlock “เส้ือคลุมรัศมีสุริยะ” เกม Asura 

 

 
 

ภาพที4่.50 Wizard “เส้ือคลุมเพลิงตะวนั” เกม Asura 
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4.1.1.5 Concept Artท่ีไดรั้บมอบหมายน้ีเก่ียวกบัเมือง Elf 

 

 

 

ภาพที4่.51 Concept Art “เมืองElf”เกม Asura 
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ภาพที4่.52 Concept Art “เมืองElf”เกม Asura 
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ภาพที4่.53 Concept Art “เมืองElf”เกม Asura 
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ภาพที4่.54 Concept Art “เมืองElf”เกม Asura 
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4.1.1.6Decorate Pixel artเป็นบา้นในธีม“ตน้ไม”้ในงานน้ีจะใชเ้ทคนิคคลา้ยๆกบัPixel art
แต่ส่ิงท่ีแตกต่างคือวิธีลงสีจะคลา้ยคลึงกบัการ paintingและ pixel artผสมกนั 

 
 

ภาพที4่.55 Pixel Art “บา้นตน้ไม”้เกม Asura 
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4.1.2 Game Rush for life 

4.1.2.1 Game Mockup 

 

 

 

ภาพที4่.56 Mock up “เมืองท่ีวุ่นวาย”เกม Rush for Life 

 

 
 

ภาพที4่.57 Mock up “เมืองท่ีวุ่นวาย”เกม Rush for Life 
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ภาพที4่.58 Mock up “เมืองท่ีวุ่นวาย”เกม Rush for Life 

 

 

 

ภาพที4่.59 Mock up “เมืองท่ีวุ่นวาย”เกม Rush for Life 
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ภาพที4่.60 Mock up “เมืองท่ีวุ่นวาย”เกม Rush for Life 

 

 
 

ภาพที4่.61 Mock up “เมืองซอมบ้ี”เกม Rush for Life 
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4.1.2.2 Painting Backgroundการทาํฉากหลงัของเกม “Rush for life” จะใช ้3D เขา้มาช่วย
ในตวังาน เพ่ือใหง้านมีตวามถูกตอ้งมากข้ึน ในเร่ืองของมุม และฉาก ซ่ึงการทาํงานในคร้ังน้ี ไดรั้บ
ความช่วยเหลือจากฝ่าย 3D ของเพ่ือนๆท่ีฝึกงานดว้ยกนั 

 

 

 

ภาพที4่.62 3D Model “ป้ายรถเมล”์ นาํมาทาํเป็น 2Dเกม Rush for Life 

 

 

 

ภาพที4่.63 “เสาไฟ”เกม Rush for Life 
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ภาพที4่.64 “ตึกแถว” เกมRush for Life 

 

 

 
 

ภาพที4่.65 “ฟุตบาท”เกม Rush for Life 

 

 
 

ภาพท่ี4.66 “ถนน” เกม Rush for Life 
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4.1.2.3 MakingAnimate NPCการทาํ NPC คร้ังน้ีกใ็ชเ้ทตนิค 3D เขา้มาช่วย ซ่ึงไดรั้บการ
ประสานงานกบัเพ่ือนท่ีมาฝึกงานเช่นเคย 

 

 

 

ภาพที4่.67 “เดก็ผูช้าย” เกมRush for Life 
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ภาพที4่.68 “เดก็ผูห้ญิง”  เกม Rush for Life 

 

 

 

 

 

 

 

 



61 

 
 

ภาพที4่.69 “คุณลุง”  เกม Rush for Life 
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ภาพที4่.70 “ซอมบ้ี”  เกม Rush for Life 
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4.1.2.4MakingAnimate Playerการทาํ player คร้ังน้ีกใ็ชเ้ทตนิค 3D เขา้มาช่วย ซ่ึงไดรั้บการ
ประสานงานกบัเพ่ือนท่ีมาฝึกงานจากนั่นทางผูจ้ดัทาํก็ไดใ้ช้การ ตดัเส้น และลงสี ไปตามปกติ 
 

 

 

ภาพที4่.71 “รถพยาบาล”  เกม Rush for Life 
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หลงัจากท่ีเราทาํรถพยาบาลทั้งหมดเป็นท่ีเรียบร้อยแลว้ ทีน้ีเราจอ้งตอ้งนาํมาเรียงกนัเป็น  
Sprite ทีละช่องๆ โดยการใช ้Power of 2 ในการแบ่งช่องดว้ยกนั ซ่ึงการใช ้Power of 2 น้ีจะทาํให้
โปรแกรมทาํงานไดเ้ร็วข้ึน ทางผูจ้ดัทาํไดใ้ช ้Ruler ในโปรแกรม Photoshop เพ่ือแบ่งช่อง Sprite ให้
ถูกตอ้ง 

 

 
 

ภาพที4่.72 ภาพการเรียง Sprite “รถพยาบาล”  เกม Rush for Life 
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ภาพที4่.73 ภาพการเรียง Sprite “รถพยาบาล”  เกม Rush for Life 
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ภาพที4่.74 ภาพการเรียง Sprite “รถพยาบาล”  เกม Rush for Life 
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ภาพที4่.75 ภาพการเรียง Sprite “รถเมล”์  เกม Rush for Life 
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ภาพที4่.76 ภาพการเรียง Sprite “รถยนตร์”  เกม Rush for Life 
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ภาพที4่.77 ภาพการเรียง Sprite “รถกระบะ”  เกม Rush for Life 
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ภาพที4่.78 ภาพการเรียง Sprite “รถกระบะ”  เกม Rush for Life



 

บทที่ 5 
บทสรุปและข้อเสนอแนะ 

 

5.1 สรุปผลดําเนินงาน 

จากการได้ทดลองปฏิบัติงานมาโดยตลอด  4  เดือน  ได้รับคําแนะนํา  ความรู้และ
ประสบการณ์ต่างๆท่ีหาไม่ไดใ้นห้องเรียน ไดเ้ห็นบรรยากาศในการทาํงาน การทาํงานร่วมกนักบั
เพ่ือนร่วมงาน ไดท้ดลองเทคนิคใหม่ๆ ท่ีไม่เคยรู้มาก่อน การฝึกใชง้านโปรแกรมอ่ืน เพ่ือใหท้าํงาน
ได้รวดเร็วข้ึนได้ทราบโครงสร้างของบริษัทเกม ขั้นตอนการทําเกมตั้ งแต่ต้น  ซ่ึงถือว่าเป็น
ประสบการณ์ท่ีมีค่ามาก 

 ปัญหาท่ีพบคือตวัทางผูจ้ดัทาํเองนั้นยงัมีความสามารถการใช้สียงัไม่ดีพอ และจะตอ้งทาํ
การแกไ้ขอยูบ่่อยคร้ัง และยงัไม่แม่นยาํเร่ืองสีมากนกั ขา้พเจา้มกัจะคิดภาพต่างๆดว้ยตนเอง โดยไม่
อา้งอิงจากของจริง จึงทาํให้จะตอ้งทาํการแกไ้ขอีกหลายคร้ัง เพ่ือใหไ้ดต้รงส่ิงท่ีไดรั้บมอบหมายให้
ทาํ และการดีไซน์ตวัละคร ขา้พเจา้คิดว่ายงัดีไซน์ออกมายงัไม่หลากหลาย และแตกต่างเท่าท่ีควร 

 

5.2 แนวทางการแก้ไขปัญหา 

ปัญหาต่างๆท่ีพบมาโดยตลอดระยะเวลาท่ีปฏิบติังาน 4 เดือน และแนวทางแกไ้ขมีดงัน้ี 

5.2.1 ปัญหาเร่ืองการใช้สี 

 การใชสี้ใหส้มดุล เป็นเร่ืองท่ีสาํคญัในการทาํงาน 2D ขา้พเจา้ยงัมีประสบการณ์ท่ีไม่มากนกั 
ซ่ึงวิธีแกไ้ขท่ีดีท่ีสุดคือ การฝึกใช้สีให้มาก การทาํงานให้มากข้ึน เพ่ือให้เขา้ใจถึงวิธีการใช้สีให้
ถูกตอ้ง และแม่นยาํ 

5.2.2 ปัญหาเร่ืองการใช้ Reference 

 Reference เป็นเร่ืองท่ีสําคญัท่ีพ่ีๆท่ีบริษทัมกัจะเน้นย ํ้าเป็นพิเศษ เน่ืองจากบางคร้ังการคิด
หรือไอเดียเพียงอยา่งเดียว อาจจะไม่เพียงพอต่อการทาํใหภ้าพเสร็จสมบูรณ์ได ้ซ่ึงอาจจะเป็นเพราะ
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ขา้พเจา้ยงัประสบการณ์น้อยมาก วิธีแกส้ําหรับปัญหาน้ีคือการหา Reference มาประกอบเพ่ือการ
ทาํงานใหม้ากๆ และประยกุต ์ดดัแปลง ใหดี้ข้ึน 

5.2.3 ปัญหาเร่ืองการ Design 

 ข้าพเจ้ามักจะมีปัญหาเร่ืองการ ดีไซน์  มาก เน่ืองจากดูงานอ่ืนๆน้อย จึงขาดไอเดีย 
ประสบการณ์ท่ีจะทาํใหก้ารดีไซน์นั้น ออกมาดูดี วิธีแกคื้อการดูงานเยอะๆ และนาํมาประยกุตใ์ชก้บั
งานของตวัเอง 

 

5.3 ข้อเสนอแนะจากการดาํเนินงาน 

 จากการปฏิบติังานตลอดระยะเวลา 4 เดือน ทาํให้ทราบไดว้่าการทาํงานในตาํแหน่ง 2D 
Artist นั้นอาจจะไม่ใช่วาดรูปเป็น เพียงอยา่งเดียว แต่จะตอ้งทาํงานตามท่ีมอบหมายให้ตรงจุด และ
จะตอ้งหาประสบการณ์ใหม้ากๆ จะตอ้งฝึกฝนมากๆเพ่ือท่ีจะใหก้ารทาํงานนั้นมีประสิทธิภาพยิง่ข้ึน 
การหาความรู้ใหม่ๆก็เป็นส่ิงท่ีจาํเป็น เพ่ือนาํมาประกอบกบัการทาํงานให้ไปเป็นตามยุคสมยั การ
รู้จกัใช้เคร่ืองมือเพื่อทุ่นแรง การหมัน่ดูงานบ่อยๆ เพื่อหาไอเดียและเสริมสร้างแรงบนัดาลใจ ท่ี
สาํคญั งานสายน้ีตอ้งการความอดทน และสมาธิอยา่งมาก เพือ่ใหง้านลุล่วงไปดว้ยดี  
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 อ้างองิ 

1. Make Game by Derek , 2013 , Pixel-art-tutorial [Online] , Available : 
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3.Alvaris falcon, 2012 , 30 Excellent Pixel art tutorials for pixel lover [Online] , Available : 
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4. Mediajerk - TBK, 2011 ,Blender 2.56 Tutorial 3 (Basics) : Edit mode, Vertex, Edges and 
Faces[Online] , Available : https://www.youtube.com/watch?v=nnRzJIb1Qos[2015 , August20] 
5. CG Cookie Inc., 2015 ,Blender 3D: Noob to Pro/UV Map Basics [Online] , Available : 
https://cgcookie.com/archive/tip-using-multiple-uv-coordinates/[2015 , August 20] 
6. Blender Nerd, 2013 ,Basics of Texture Painting - Blender Tutorial [Online] , Available : 
https://vimeo.com/56637873[2015 , August21] 
7. ecskills21, 2013 ,Blender Save Image as JPG or PNG[Online] ,Available : 
https://www.youtube.com/watch?v=-vyISbqnjGU[2015 , August21] 
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ภาคผนวก 
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ภาคผนวก ก เกม Rush for life(Old) 
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เกม Rush for lfe (Old) 

 

 เกม Rush for life เคยใช้ Pixel artทั้ งหมดในการทาํ ซ่ึงภายหลังทางผูคุ้มเกมได้เปล่ียน
สไตล ์Pixel art ให้กลายเป็น Painting แทน โดยใช ้3D เขา้มาช่วยในการทาํ ทาํให้เกม Rush for life 
ในปัจจุบนัมีความถูกตอ้งในเร่ืองของมุมมอง มากข้ึนและสามารถทาํงานไดเ้ร็วข้ึน และน่ีคือส่วน
หน่ึงของเกม Rush for life ในรูปแบบ Pixel art 

 

 

 

ภาพ รถพยาบาล 
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ภาพ รถเมลส์าย 8 

 

 

 

ภาพ รถเก๋ง 
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ภาพ รถมอเตอร์ไซค ์

 

 

 

ภาพ ฉากหลงัเกม Rush for life (Old) 

 

 

 

ภาพ ฉากหลงัเกม Rush for life (Old) 
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ภาพ ฉากหลงัเกม Rush for life (Old) 

 

 

 

ภาพ ฉากหลงัเกม Rush for life (Old) 

 

 

 

ภาพ ฉากหลงัเกม Rush for life (Old) 
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ภาพ ฉากหลงัเกม Rush for life (Old) 

 

 

 

ภาพ ฉากหลงัเกม Rush for life (Old) 
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ประวตัิผู้จัดทําโครงงาน 

 

ช่ือ-สกลุ   อิทธิ พิทกัษส์าริน 
วนัเดือนปีเกดิ  16 มีนาคม  พ.ศ.2537 
ประวตัิการศึกษา 
ระดบัประถมศึกษา ประถมศึกษาตอนปลาย พ.ศ. 2549 
    โรงเรียนดลวิทยา 
ระดบัมธัยมศึกษา มธัยมศึกษาตอนปลาย พ.ศ.2555 
    โรงเรียนเตรียมอุดมศึกษา พฒันาการ 
ระดบัอุดมศึกษา  คณะเทคโนโลยสีารสนเทศ สาขาเทคโนโลยมีลัติมีเดีย พ.ศ. 2558 
    สถาบนัเทคโนโลยไีทย – ญ่ีปุ่น   
ประวตัิการฝึกอบรม 1.GoogleAdmob 2014 
    2. Workshop หวัขอ้ "Digital Painting" โดยผูส้ร้างแอนิเมชนัเร่ือง "ยกัษ์
ผลงานทีไ่ด้รับการตพีมิพ์      -ไม่มี- 
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